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Section : General Knowledge

Q.1 Si. Jefiw 31efl, St URd & - gehifaeri g, &1 & A9 A AT SATdT AT
Ans x 1. qr3¢ B4 3% Ef3AT (Mountain man of India)

x 2. k@R 89 311% Ef331 (River man of India)

« 3. S804 316 Ef337 (Birdman of India)

x 4. dreHT 3T 3 (Waterman of India)

0.2 fHfafEd & I e1-3f &, adi= =Frare & =Araneher S FRRe Egrea &2
Ans x 1.d8 URd &I APTRS &1 d1fgvl

2. 38 U auf ad Bl 3 ATy 8§ 37feahl a1 arfev|

x 3. Fg Irgufa &1 317 & vep yfafdd e e @nfgul

x 4.8 BT I HF Y qu deb (bl 3 =ATATA &l =A1Arefer 81T Arfgv|

0.3 Fufarf@d 7 3 -1 Ja1sl e 3 qursl F Adfad 481 412
Ans 1. %Ml fda@rHg

x 2. el dllstad 1%

x 3. oTell §4RTT

X 4. TIT-E Il
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0.4 fufarf&d @S & 999 Idrqe Ial A Jaferd HI
a) STQ1SC i) ISR
b) 1Y ii) 3y GAA
c) UCIfer ™ iii) SREs

d) ®IIell iv) 3nfsem
Ans 1.a)iv,b)ii, c)i,d) iii
x 2.a) i, b) iv, c) iii, d) ii
x 3.a) iii, b) i, ¢) iv, d) i

x 4.a)i,b)iv, c)ii, d) iii

Q.5 HIRd H fag3il, gReml 3MR digl oI S-@A & fqavor & Ade # Fgferf@d 7 I o19-3 s
el g2

1. 3BT AT T g SHTAT IgHBAP & dAT Sl SHHASAT 70-90% A1 39 HfAS
el

2. 99l §3 enfifes feuiE®, R, 137 ¥ d 7eR1Y 3R ER1d $ Aed 831 7 Y&d &l
3. 31 3R SR dYT Gdb & UoR H digl bl Jeci@-N SIS 2l

Ans x1.%dd 23R 3
x 2. Hdd 3
o 3. Pdal 1

x4.1,2 3R 3

0.6 frgferfad & @ feda i sNedst el & i feran?

Ans x 1. 3AI& oflel T8&

x 2. HeTcH el
X 3. IRGR eI HATS gl

¢ 4. 9.3R. 3idgHR
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0.7 Jifaer & fFufaf@d 17B¢ ¥ F S19-31 31B¢, 3 ATATAT 1 RATYAT BT graen-i
BTl 872
Ans x1.37<8q 224
x 2. AT 218
o 3. I3 214
x 4. 318G 222

0.8 §3I¢ 2024-25 § &) 315 HIYUN & AR, BIqel WRd AIAF_ Ja13f &1 gfAfad
fopami

Ans 1. 14 @33
x 2.2.4 B3
x 3. 11303
x 4. 21 B3
0.9 &y Ardaife &4 & d 3 7 41 2025 B 'did ellde A TA3RS 3R TAAR3N AfdT

3®13¢ (bob Global Women NRE & NRO Savings Account)' @i f&3r1, 3l fady w9 @
Afgarsit & fore §1-T 37147 Ygell NRI &TdT &2

Ans x 1. PR IB
X 2. MR Xe I
x 3. G3T§ J9Md d&
v 4. 9% 316 g8lal

0.10 9Rd & fAgfarf@d Wifas gur § I feadl Hars 3ifean &2
Ans x 1. ddY HerA
¢ 2. IrFdidig gor
x 3. YRAT BHg el
x 4. 3T BT
Q.11 5 WIRAE A 3 AP ygIdl H TP AR 3TP! ofd F e F felv Jbed' Ugd L&
é17?
Ans x 1.3TR1EsS
x 2. 93d
» 3. fearaet geer

x 4. giRamon
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Q.12 fEa®T A= o1 16 Far A 3 el AT ATAT 9118 & 3P AR BT B g3u1 &
31 g Arfae AR A IERT BT AT 57 ATRAT & 455 AT A1?

Ans 1. AEIS-U-ARTS
x 2. 3¢ Sl
x 3. g0 A=
x 4. 3R IR

Q.13 1899 H fF Hell (Mitra Mela) ATHS 3[& JXAT B WTYAT Fferf@d # d foa Afb g1 H
Mg off?

Ans x 1. ST 30MeR facie 3R el dlsidd 3T

x 2. Tedl dTstad 31 3R Ao IiRA
x 3. T9f= g ret 31R ren efrstad 33

o 4. T3 SHER ATIRBR 3R 07T STHIGY AR

0.14 fFEfafdd ¥ & S19-a1 [AANEASR MRd b AFIfT B UTeHe 872

Ans  x 1.39F 3G PIe A B LK PR U Ugel al HelH $1 44 Alfed &1 S anfge
v 2. gufd fodt off 35y fayfaenerd o1 efemfd & o 8
x 3. Jreufd et off =rarera & ufa 3aRert 78 81

x 4. 39 397 BrABT & SR1 B Wt = § 3ufRd 819 & fov 981 el 57 b dT &

0.15 dsflie s 30y 2024 fFufafEd ¥ A B WU R ARG fBAT 51=4T o012
Ans x1.4s8
x 2. gfeare
x 3. J¥d
v 4. 78 et
0.16 3[ 2024 H, JANI AT (EC) A YT FIIABIPT (NaturAfrica) 1dbd & e & &Y

7 qdif 315611 7 Y& U 17 arct €18 MAfera—T AT 3T &q 9T ol 6 g @
faferfard d 4 fea g &1 gar fean?

Ans x 1. ImArferRn
x 2. e
x 3. B

@ 4. darfan



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Q.17 30 3ageR 2024 do YId S-SRI & FTAR, Yol 31 31 Agwg Ay Ay #§ Ffaf@a
7 3 f5y ug W IRAA €2

Ans 1. IgTH Y BT 3Y-HENIRG 3R FYh AP Add (GBI Jgg BT HeAe

x 2. UGTh Y YATARU] BTIhH Hl BIIB fAGLND
X 3. UYTH AY HEIT bl el
x 4. AGTh MY 3N AP WTa- Bl Hereerd

0.18 R faen= &1 ITB< 340 fFyfafEd ¥ I feud Wi 82
Ans 1. 983 T 6T RATTAT B 5779 B B U T AT $I FHgfb
x 2. AT 3T & fAmfoy
x 3. fad 30T T 2maAr
x 4. AT AT & 5

Q.19 fHferf@d & & ®i9-31, wikd § e garfi gl 18 &2
Ans  x 1. GIfEM

X 2. 3R e

o 3. 333

x 4. A13aRIq b9

Ans x 1. 351 gedr
2. 3TcI3EIT f&efsit

x 3. sogdmer
X 4. Scfd

Section : Logical Reasoning

0.21 3 A=Y &I 94 10 31 A U v qF Ig=AT & Ja1 de &1 A0 ST &
QI It A def &1 3R $Ra

SP - NK - IF

TQ - OL - JG
Ans 1. FC - AX-VS

x 2.ED - BX- VT

x 3.FC - BX -VS

x4.ED - AX-WT
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GET IT ON
Google Play
0.22 IAfg Y=AT 8613745 & YdP fayd 3i § 2 SNST SATU doAT Y& IY 3ip 4 A 2 €141 MU

dl 30 YR &1 75 I F 910 A i deor ¢ A g 3Pl BT AT 941 g2
Ans x 1 14

x2 16
3 11

x4 10

0.23 & ¢ g@ell § 9Y-f¥% (?) & AT 4R 1 A0 A1fae?

31, 35, 43,55,71,7?
Ans x1.90
x2.93
¢ 3. 91

x 4.92
0.24 &1 71 @t § Uy [&Ig (?) & AT 9 =T 31 A1fRU?

211265398167 ?
Ans x1.265
x 2.256
3. 266

x 4.260

0.25 AT Y, J, K, L, M, N, O 3R T, U & HUT UP IWQ I[U §, dAfed w3 781 fp d st pu A
FFUEN )P D PAA G TR IQ MV EIN P HU P UH SR IQT AT IN3R T

& di9 Pdcl U a1 I\ AT g1 L BT M & Sl FHUR IW@T 3T g1 O Y K & 3 fopdt
T[T YR IMT 3T g1 K 31R 0 & &9 fpdl 9 3@ v €2
Ans x1.d9

x 2.dR
x 3. ar

v 4. T®
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0.26 TG 19 f& fAfga a8 J Ul 6 A Fdfead &1 K) 30 33t a9 I LL 17 I T&fda g1 gura
dd &I IR Hd §U, LC 10 QU I10 faspedl 7 & fopud Adifaa 82

Ans 1. ME-3
x 2. NF -5
x 3. MF -7

x 4.NE -3
0.27 FHferf&d @ g@en &1 daH eifae 3R QU e 9y &1 3R difsel
(d0)456798123365496465489846546532(gIV)

U0 fpda O 3ic &, iS50 3 AP & 8P Ugd ve quf 3f @ 3R i a1 & v fawy 3
&?
(A1 0 3R 1 oft quf o &1)
Ans x 1.dRR
x 2.d9
WER:T
x 4.919

0.28 39 A=Y &1 994 HIfsre Sy F@t 3 ave A Adfda € o fop FuferfEa wg=al &
WO E
(A1 J@AT30 DI 3b gcP 3idl # dis a1, WAy quf J@arsil gr &1 -t =ifge|
3QTERT & felv 13 Bl ofifSIU - 13 UR ATBATT 3 6 13 & SN31 / g1 / 300 B 13 W
1 11 FHdr 8113 3 131k 3 T dIzd 3R R 1 3R 3 W IIOTAY JAfBATT BT HI

srgafa & 1)

(3, 31, 43)
(7, 36, 64)

Ans x1.(14,55,101)
x 2.(21,50, 132)
v 3. (11, 41, 85)

x 4.(19,47,223)
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Q.29 U fAfYd P iy A,

U@H &1 31 &, 'U, H &1 77 &'
U%H T 314 &, 'U, H &1 351 ¢
U&H &T 31¢f &, 'U, H &Y Arar &'
U#H &1 319 &, 'U, H &I frar &'

IfE N% MH#R@LEK &, dl M &T K I T Taief 872
Ans x 1.9
¢ 2. fadr
x 3. Tra

x 4. A

0.30 FUfAf&d 31eR-g@c 1 A if3v 3R 39P q1g A alad ¥Y &1 3ax dIfsre) Brad
&ad 9r¢ I g0 $i 1 2
(FIV)y MJUNLGTEXSQOAIVWBCH DK (3I0)
33 quinTer g § 1¢ 81 A AW H#ER 3R 91¢ 81 I uiad 38R & €9 fa 7ER
ard 82

Ans ;<1.3.T

x 2.dR

x 3.Udb

4. A

0.31 3150 39 e 7 ofif F 113 o o= 377 A F 199 w3 R &1 Fan ¥ fpa faeneff €2
Ans x1.28

x 2.31

x3.30

v 4. 29
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0.32 fFuferf@a & 3 A AeR-TE g, # 3R % & yfdwATfyd fHar -1 9ifge G 15 :: &
TEIR P AR-TAE LA S A B e AR Y, : FAES AR S HR-AFE P b AT &b
de 3R ddy & Jura @ se?

#:LPO:EIH: %
Ans x1.#=MQP, % = DGH

x 2. # = MSR, % = DHG
x 3. #=MQO, % = CGF

v 4. #=MQP, % = DHG

0.33 39 fddey 3P Td &1 94 HIfSU 371 G &1 31 $7 & fere A2 & 18 nefa ¥ yy R
(?) & AT 93 3MCA |
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Q.34 f{U U HER &l BI 3W AR 39P dI< U ITC Yy $1 30 &1 Pradl Bdel 9¢ A ¢ B
ST arfgel
(STO) VAINYANAVIHSLAGHTAKOPDRRAD U (GIV)

afg g@enr & Gt Ha ger XU 10, df SI4-AT 38R 10 A Bal gPI?
Ans x 1A

x2.0

x3.U

o4

Q.35 Iqfg '+ &1 31¢f =, '— P71 31ef 'x', 'x* BT 37 ', 3R '+ &1 3¢ '+ g, Y Fgferaa gfiaror
T ygy-fRIg (?) & AT Y3 &7 3M0M?

324 +6x8-32+251="7
Ans x1.12

& 2. 49

x3.38

x4.27

0.36 39 A &1 T4 HIfSC SR W@t 3 yR Adfda & G R Fufafaa ag=a
&Y WwWATT Adfaa &
(A1e: J@AT3M DI 376 gcP 3idl # dis o1, WAy guf J@arsil v $i -t =ifge|
3QTERUT & folv 13 Bl ofifSTU - 13 4R ARBATT 3 6 13 & ST / g1 / 300 B 13 W
1 311 FHdr 8113 3 131K 3 T dlzd 3R R 1 3R 3 W 0T JAfpATT B3 HI

srgafa & 1)

(105, 51, 193)
(109, 46, 192)

Ans x 1.(121,41,169)
x2.(137,37,41)
x 3.(145, 69, 213)

4. (156, 26, 219)
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Q.37 &1 31 9@l &1 daH +fif3v 30 39P a1 AU 10 9y &1 30 difsrel Pradt dad aiv 3
&T0 &Y St arfev) (It =10 Fad U 3id arell =AU §)
(dU) 859633547865813565183789855 (aI0)
Ot fopa-ft fayy H=rt €, 5 d Ud® & 31F U Ue fayn Jw@= & 3R Sie arg 7 oft
U fayq H&=T &7

Ans x 1.dR
;(’Z.tﬁﬁ
¢3.a

x 4. 91d

Q.38 If; ‘B’ 1 3+ 8, ‘F &1 3tk -’ @, ‘G” T e “+” @ 3R W T 3¢ * @, Y Fgfarf¥a
IfiH0 § yy-fag (?) & AT 9 T 3109712

24G4E12H1F18=7?
Ans x1.-6
x2.6
¢3.0
X 4.-3
Q.39 3iSH quinrenr o1 g neniRd, Fgferf@ad R AeR-ayg 4 A di7 fHdt AT aiis I ve
I § 3R 9 UPR U YU 9-1d &1 BIF-3T 378R-99g 39 I I Adfia A8 &2

(AVS: 3T HER-TYE, HER-AYE | A1 /R 1 &A1 A1 39 AT R 3menRd &l
)

Ans x 1.FEA
x 2. UTP
« 3. VVQ

x 4. ROM
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Q.40 3iASH quinTel o4 & AR 4R, FHfefEd IR 3gR-Ag Al § A |1 v Afga daiie 3
UHIAT & 3R 3 YBR d U JYU §-1d &1 DI7-AT JGR-TYg IH 39 I4 I Adfad 181 &2
(A1<: 3RTd HER-TYE I, 3T A1 /IAR0 b1 J=A1 A1 7 3961 (AT v 3weniRd =& 21)

Ans 1. CE-DF
x 2.QT-RU
x 3. PS-QT

x 4. JM-KN

Section : General English and Comprehension

Q.41 Select the most appropriate option to fill in the blank.

The _ silence in the courtroom made everyone nervous.
Ans x 1.smooth

« 2. deafening

x 3. deaf

x 4.slow
Q.42 Select the option that can be used as a one-word substitute for the given group

of words.

To move quickly over the surface
Ans x1.Gliding
x 2. Curveting
x 3. Swoop

& 4. Skim

Q.43 Select the most appropriate ANTONYM of the given word.

Considerable
Ans 1. Inadequate
x 2. Inattentive
x 3. Usual

x 4. Common
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0.44

Ans

0.45

Ans

Ans

Q.46 Which of the following is a 'text to world' connection from the passage?

247

Select the most appropriate meaning of the given idiom.

Lose your head
« 1. To lose control and not act in a calm way
x 2. To physically lose something important
x 3. To become wiser after a difficult experience

x 4. To think logically in a tough situation

Select the most appropriate option to fill in the blank.

He answered the questions as as possible.

« 1. inappositely
x 2. decently
x 3. inaptly

« 4. accurately

Comprehension:

Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in
the modern world. Students today depend heavily on the internet for accessing
information, attending online classes, and connecting with peers through social
media platforms. This digital revolution has undoubtedly made education more
flexible and accessible, especially for learners in remote areas. However, it also
introduces several challenges. Prolonged screen time can lead to physical health
issues like eye strain and disrupted sleep, while also reducing opportunities for
in-person social interaction. Moreover, not all students have equal access to
digital devices and stable internet connections, creating a widening gap between
privileged and underprivileged learners. Despite these concerns, the educational
benefits of technology are immense. It supports self-paced learning, encourages
curiosity, and allows teachers to incorporate interactive tools that enhance
understanding. Striking the right balance between digital resources and traditional
methods is essential to ensure a holistic and inclusive educational experience.

SubQuestion No : 46

x 1. The author prefers traditional learning methods.
% 2. The passage is about one school’s computer lab.

x 3. Technology is only important in science classes.

« 4. Many students around the world use technology to learn.



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Comprehension:

Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in
the modern world. Students today depend heavily on the internet for accessing
information, attending online classes, and connecting with peers through social
media platforms. This digital revolution has undoubtedly made education more
flexible and accessible, especially for learners in remote areas. However, it also
introduces several challenges. Prolonged screen time can lead to physical health
issues like eye strain and disrupted sleep, while also reducing opportunities for
in-person social interaction. Moreover, not all students have equal access to
digital devices and stable internet connections, creating a widening gap between
privileged and underprivileged learners. Despite these concerns, the educational
benefits of technology are immense. It supports self-paced learning, encourages
curiosity, and allows teachers to incorporate interactive tools that enhance
understanding. Striking the right balance between digital resources and traditional
methods is essential to ensure a holistic and inclusive educational experience.

SubQuestion No : 47

Q.47 Select the most appropriate ANTONYM of the word 'accessible’ as used in the

passage.

Ans x 1. Available
x 2. Open
x 3. Easy

« 4. Limited
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in
the modern world. Students today depend heavily on the internet for accessing
information, attending online classes, and connecting with peers through social
media platforms. This digital revolution has undoubtedly made education more
flexible and accessible, especially for learners in remote areas. However, it also
introduces several challenges. Prolonged screen time can lead to physical health
issues like eye strain and disrupted sleep, while also reducing opportunities for
in-person social interaction. Moreover, not all students have equal access to
digital devices and stable internet connections, creating a widening gap between
privileged and underprivileged learners. Despite these concerns, the educational
benefits of technology are immense. It supports self-paced learning, encourages
curiosity, and allows teachers to incorporate interactive tools that enhance
understanding. Striking the right balance between digital resources and traditional
methods is essential to ensure a holistic and inclusive educational experience.

SubQuestion No : 48
Q.48 Which sentence best summarises the passage?
Ans 1. Technology transforms education while presenting both advantages and challenges.
x 2. Technology completely replaces traditional education.
x 3. Technology harms students’ health but offers some benefits.

x 4. Technology only benefits privileged students.



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Comprehension:

Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in
the modern world. Students today depend heavily on the internet for accessing
information, attending online classes, and connecting with peers through social
media platforms. This digital revolution has undoubtedly made education more
flexible and accessible, especially for learners in remote areas. However, it also
introduces several challenges. Prolonged screen time can lead to physical health
issues like eye strain and disrupted sleep, while also reducing opportunities for
in-person social interaction. Moreover, not all students have equal access to
digital devices and stable internet connections, creating a widening gap between
privileged and underprivileged learners. Despite these concerns, the educational
benefits of technology are immense. It supports self-paced learning, encourages
curiosity, and allows teachers to incorporate interactive tools that enhance
understanding. Striking the right balance between digital resources and traditional
methods is essential to ensure a holistic and inclusive educational experience.

SubQuestion No : 49
Q.49 According to the passage, what is one challenge of technology in education?
Ans x 1. It eliminates teachers’ roles.
& 2. It causes excessive screen time.
x 3. It reduces access to information.

X 4.1t makes lessons boring.
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in
the modern world. Students today depend heavily on the internet for accessing
information, attending online classes, and connecting with peers through social
media platforms. This digital revolution has undoubtedly made education more
flexible and accessible, especially for learners in remote areas. However, it also
introduces several challenges. Prolonged screen time can lead to physical health
issues like eye strain and disrupted sleep, while also reducing opportunities for
in-person social interaction. Moreover, not all students have equal access to
digital devices and stable internet connections, creating a widening gap between
privileged and underprivileged learners. Despite these concerns, the educational
benefits of technology are immense. It supports self-paced learning, encourages
curiosity, and allows teachers to incorporate interactive tools that enhance
understanding. Striking the right balance between digital resources and traditional
methods is essential to ensure a holistic and inclusive educational experience.

SubQuestion No : 50
Q.50 What is the most appropriate title for this passage?
Ans x 1. How to Use Social Media Safely
% 2. The History of Technology
« 3. Technology’s Role in Education

% 4. Health Problems Due to Technology

Q.51 FHferfErd are &l f&U 10 fabedl § I 39gwh BRD & gIRT Iuf B
13 FeA dlcll & $IS 3AdIR 8l al Sirdl

Ans x 1.0

x2.39

¢3 W

x 4.4
0.52 Fuferfad faseul § 3§ ‘de &1 faelly U= SI-AT1 82
Ans x 1.1

x 2. gom

v 3. 91

x 4. 319
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Q.53 '$YST' HI gIgardl I3 8 -
Ans x 1.8MH

x 2.9

@ 3.3

x 4. 3

Q.54 '31T3 &1l AT qerdx &1 el 37 & -
Ans  x 1.7c &7

@ 2. G-I AT

x 3. BIfRIR 91

x 4. TR BRAT

Q.55 ' & R FAbd-r gera¥ o1 A& 71 go1-
Ans x 1. Yreq &bl s gl

¢ 2. A & & e 31

x 3. 1 & 18 ST

x 4. RN 711

Comprehension:

f&T 7T Terier & 3memR R Agifed g2 & 3R dfse-

IR 9Teq Bl & Wb A BT YA ¢ SH W37 B AR Afeh IT avq BT WIaqu] & gedd
foaT STTaT 81 3% Afth-fa, -, aRd-fd, eraia 3fe off et Sirar 81 anfes ¥ o a8l
BIY B4 & 3l bl HIG@IV Bl &1 QTR § $B I gU Al gIRT [AvI-avg, Afeh, W1, g
Ud 299 &l IIBR WU H 3 dRe Y BT el & o Irde &b e @ dve RAfd & Ib | @
T Afth & Ry b STl @137 I 3URT ST &, IAb! ATTHT Pl Y B BT YA &Il 8l
qUIHTH AT YETA BT MR &l &1 397 AT W A9y ad a1 Sidr &1 3@ Jenefard!
AT €1 AT B WESTAT 3R ARAT UR AP FeT fon Sl g1 Sie-8ie e 3R W1fdes Adig
YIS 6 I &1 3dg Tearelf (T dre 33T), TBTEiE I (IAR2AE Bl ASH), IHARTI0 (B
TRg), AAGETS R (Tgel au) 1S T YEIfRTeR ¢l

SubQuestion No : 56

0.56 YW & qrde ¥ 3 86—

Ans x 1. 3UATHGAT Y@ &7 3R 8l 2
x 2. 391 ¥ RS dT R QY ae f&m srar 1
« 3. 3R BT I &t &
x 4. 397 geefardt 391 gl gl
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Comprehension:

f&U 7@ Terier & 3memR W Agifed g4 & 3T dfe-

IR g APl & Ibd 2Teq Pl YA &1 SHH Y1371 P HeR Afeh AT a¥q b1 Wraqof = uvdd
a1 ST &1 58 AfB-F, -, aid-fm, eIt 3 off a1 san &1 v § o a8
B B & 3l fAcbell H IQ@IV Bl &1 AT § S8 g U Asal gk [Avg-ag, SAfeh, W7, g
Ud 297 Pl PR R H &7 AE IR BT ST ¢ fob Urde & AHA IR1 ave R & b | @i
T Afth o IA®Y b F1gl @I Bl IHIRT ST §, 3ch! ITI3T Pl Y PR BT T @il ¢
qUIATE T AT BT 3R &l &1 397 AT d 1R 399 g f&m Sirdn &1 @ genefard
T &1 T T TETdT 3R IRAAT IR AP Je &1 STl g1 BIe-BIe AT 3R Wb Aarg
G $I A 81 g Tl (R@rv aet 341, Yp1ereic I (IRATE Bl ASH), YHARTIT (&
oRgp), AT gRI (T8l auf) 37E yg AP &l

SubQuestion No : 57
Q.57 'MNAME I IsH' P didd Y T A g—
Ans 1. UBIMES T
x 2. JTAGET g3
x 3.gdg Jndi
x 4. YHARTI0T
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Comprehension:

f&T 7T Terier & 3memR R fAgifed g4 & 3R dfse-

IR QTeq FRIFABl &b Wb A BT YA ¢ SH W37 B AgR Afch IT a%q BT Waqu] & Jedd
foaT STTaT 81 3¢ Afts-fa, -, aRd-fd, ersaia 3nfe off et Sirar 81 Yanfed ¥ o a8t
BIY B & 3l bl HIG@IV Bl &1 3@ § $B g U Asal gIRT [Avg-ag, Afeh, W7, g
Ud 299 &l ATBR ®Y § 3 dRE Y BT el & 5 qrae &b A @3 ave RAfd & I | @y
T Afth & WawY b STl @137 I 3URT ST &, I AT Bl Y B BT I &Il 8l
qUIATH AT YR BT MR & 81 390 AT IR A9y aa f&§a1 Sidr &1 3@ Jenefard!
AT €1 AT Bl WESTAT 3R ARAT UR AP FeT fn Sl &1 Sie-8ie e 3R W1fdes Adg
IR b faQIvdm 81 dg At (10 et 38T), Tp1ereia I (AR2ATE BT Agb), AARII0T (fEel
oRg), ITAGEreH g1 (Yl auf) 37fE g SERABR &l

SubQuestion No : 58
0.58 Y@IRA b1 uIeT ) fyAwar g 7 3 —
Ans x 1. faoi® arwr
v 2. 81-8I¢ ™
x 3. 3fec TR
x 4. B q=argell
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Comprehension:

f&T 7T Terier & 3memR R fAgifed g4 & 3R dfse-

IR 9Teg Bl &b Wb A BT YA ¢ SUH W37 P AR Afeh IT avq BT WIaqu] & gedd
foaT STTaT 81 3¢ Afts-fa, -, aRd-fd, ersaia 3nfe off et Sirar 81 Yanfed ¥ o a8t
BIY B & 3l bl HIG@IV Bl &1 3@ § $B g U Al gIRT [Avg-ag, Afeh, W7, geT
Ud 299 &l ATBR ®Y H 5 dRE Y BT el & S qrae &b e @3 avg RAfd & Iob | @y
T Afth & WawY b STl @137 I 3URT ST &, I AT Bl Y B BT I &Il 8l
qUIHTH AT YR BT 3R & &1 397 ATl IR A9y aa &1 Sdr &1 3@ Jenefard!
AT €1 AT Bl WESTAT 3R ARAT UR AP FeT fn Sl &1 Sie-8ie e 3R W1fdes Adg
IR b faQIvdm 81 dg At (10 et 38T), Tp1ereia I (AR2ATE BT Fgb), AARII0T (&l
oRg), ITAGEreH g1 (Yl auf) 37fE g SERABR &l

SubQuestion No : 59
Q.59 fg & I Y@ifax &1 vafa & —
Ans x 1.Ffb6 &F

x 2. 9IRd =

x 3. 34

o 4. geATHH
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Comprehension:

few oTw sTerier & e ur fAgifed gei & IR fSv-

G 1eg Al & Wb A Bl YA g1 SIH @13 P TR b AT IR BT HaYUT 0 IR
3T ST 81 5% -, urg-fo, IRa-fR, ersgiasT 3nfe oft oar e &1 3@f & 9reg 9
B R & 31 el 5 @10 Bl &1 3T § $8 I §U Al IR fav-awg, b, W1, g2
Ud 299 &l ATBR ®Y H 5 dRE Y BT el & S qrae &b e @3 avg RAfd & Iob | @y
T Afth & WawY b STl @137 PI 3URT ST &, IAb! AT Bl Y B BT Y1 &Il &8l

i AT YA &7 3R &l &1 398 AT 4R 39 gt fer rar &1 ¥ gerefard
AT g1 AT &Y TSIl 3R AT UR AP Jcf &1 ST g1 BI-8BIe ar 3R W91 Jdig
@I B fAATdr 81 g Tl (R@r0 aet 38T), Teb1ereic I (RLME BT ASH), IAARTI0 (f&ed
oRg), ITAGETeH g1 (Tgel auf) 37fE g SERASR &l

SubQuestion No : 60
0.60 '@INIfA®’ &I ey o< g 7 A &--
Ans x 1. 3axarrfdse
2. F@rfase
x 3. Upfds
x 4. ardfas

Q.61 MS UTaRUTEE H B3 $T ¥138 A Y& B & ferv Fgferf@a 7 3 oI-M baer it
BT 39T fBAT SATT 872

Ans 1. Es
X 2. Fl
X 3. F7

x4 g3
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Q.62 UHUY ds 2019 H, 2R B d¥e, ASC, AR H 37clsd B3 3R R &I SIRCHIS HI1 &
fere sifié®e $HRIT (keys) T &2

Ans 1. CHRC Bl AFR-3TATSH BIAT - Ctrl + L GaTY; SaRE Pl 823118 BT - Ctrl + R GaTy; Tex
CRC - Ctrl + E; TRE Pl SIRBIS BIAT - Ctrl +

X 2. THC Pl AUL-37AT8H BT - Ins + L TaTY; TRE Pl A3e-37l18H &R - Ins + R GaTY; Je?
CHRC - Ins + E; SR Bl AREHIS BT - Ins + )

X 3. TR B! ATFe-3TcT189 BT - Shift + L GaTU; SRE B 82-3Tcl8T BT - Shift + R GaTU;
X TRC - Shift + E; TR Bl SIRCHIS BT - Shift + )

X 4. CRS Bl AFe-3TcT8d BT - Alt + L TaTU; TRE Bl A8e-37alTeH &l - Alt + R a10; Jex
CRC - Alt + E; TRE Bl SIRHIS BIAT - Alt +

0.63 LR dIARV I RACH U AT YATd T 872
Ans x 1. e &1 38R H1IUELH
v 2. FARPA 32T URRT 3R HIQH
x 3. 961 g8 §cRIC PRI
X 4. 961 g8 JRan
Q.64 UHUY UIaRUise I® H3d Ay, FAgferf@d & 3§ &14-31 fddbey U 41 < (blank)
YSfe e F17 BT A& dddI &2
Ans x 1. View ¢§ Ilal 31X Blank Presentation Jcide &
x 2. Insert 39 UR fdcid &9 37R Blank Slide g1
« 3. File > New > Blank Presentation Jeiae @3 3R Create TR facia ®3 |
X 4. 3BT IR A82-faeies B AR New > PowerPoint Presentation |

0.65 $0d }dR (email structure) & TR BT AT AT &2
Ans x 1. B3R, Jeolae dle, dfal 3R S8

x 2. 883, geoide ofred, foid 3R R

v 3. 857, Jeolae e, dial 3R AR

X 4. 833, YB3y, &8 3R R
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0.66 MS UHAd ¥ seT Iié Hvd 999, FgfarfEd & d 17-91 94 I &7
Ans x 1.321 I B AT, MS U ol WaTfeld ®9 I sere ¥ R Jal P 368l &R odl &l
x 2. MS THIA & 32T TifET el IRATHS A1 P AT BIH B 6, CaRe 5l & I el |

X 3. MS U, IR Pl RIS I7 360! BH H 3T AT B bl A ST &, ifeb d U A1 Hs
BIcTH AT T8 B Fbd|

¢ 4. MS T B, U BicTH BT I BIb ol Ml (BT 3 Abhdl g, i IS PIs IR s
HIGS! & AR AT BT A8 &, al 3U BCH Al (Custom Sort) fIbed BT 34T AT & |

0.67 UHUY U 2021 §, Y& 931 U I AT BiciH 883 (row or column header) &1 fiiec &37
& ufepar w2

Ans x 1. Page Layout > Print Area > Set Repeating Rows/Columns
« 2. Page Layout > Page Setup > Print Titles > Rows/Columns to repeat
« 3. File > Print > Repeating Labels
X 4. View > Repeat Rows/Columns
0.68 RIeHd RIS I 9910 IWA dAT Vel B VAR &I I B & foll 9 $I9 yg
B3l &7
Ans x 1. USI-aRY IR AR
» 2. e diedaR
X 3. TP HAR
x 4. ey AfefhdbeH

Q.69 FHfaf&d & & AISeR JR&T & Yol HIIGS HI A &2
Ans x 1. T8I, 3RS AT 31X 39aTeerdl
x 2. AR, 31T 3R Iuctedr

3. =TT, 39T 3R 39areerd

x 4. G-I, 37ESdT 37 WO dr

Q.70 3YE 3R 332YC f3arsy & Jde F fFAuferf@d 4 d S19-91 24 I 872

Ans x 1. HigH Pdcl U 3132Ye f3arsd &l

v 2. HISIBI- U gYC f3a1ey §, 3R UIsiae? U H13cYL f3arsw &l

x 3. SRPIE A U 37132YC f3are &, 31N wiiey Ush Y2 f2ares &l

X 4. TIXPIH Hdd VP gAYL f3arey ¢
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Q.71 'CC' Wies &1 Yuf ®U FT & 3R sTBT FT 1A &2
Ans x1.'Closed Copy (deils8 ®idl)' 3R ST®BT U SHc Pl BIRAs a4 U AP & folv faT Sirar &l

x 2.'Confidential Copy (PIBs I ®idl)' 3R S8BT 3UANT SHA dec Pl URBE B4 & felv
foar STre &1

« 3. 'Carbon Copy (PTe P’ 31X STBI 3UAPT SHA oI U Pidt Bl fafsraa rfafes Joft
AT B W F v B srdr gl

X 4.'Contact Copy (Pi=cae ®idl)' 3R TP 3TAPT YD I H SHeT Ugdl Bl 51s & v foa
ST 8|

Q.72 TWEIR ¥ BI AT 29 AP Y ATSPIHIG GraRYise Usic e § il STl &b qfaen &dr
e?
Ans 1. 3T9¢
x 2. 133
x 3. gangs N
x 4. 89
Q.73 uHuy 43 ¥, fAgferf@Ed 7 3 e faeey gR1 favgd fie fiag uar- faan irdn &, i I &l

siegie 3l e &34 A gga "I, 951 3R 3R Tur Arga it AT JarAfera
B3 b Ffae qar &2

Ans x 1. SIRIAC W Ee-fdcte B, Print Tctae B3, 3R R Ppi-eae B A Print Preview |

x 2. View ¢§ IR 311U, Print Layout Jeide &3, 3R R Print Preview IR facid &
« 3. File S UR STV, Print Aeiae &3, 3R R Print Preview 99 § Wi Afeg qaraifard &3

x 4. File 29 IR 3T, Print Aalae P9, 3R R Print Preview 97 & &fcH X Page Setup TR faid
B
0.74 &t $ia ¥ FAfée faf¥ & 3Ty & 2130 ST (time window) &1 T &1 38T RIT 8?2
Ans x 1. IR P 3R R SHA Bl WAHBAT T

v 2. U AT [0 AA1 & iR IIed SHel T AHEIPd Bl
x 3. 37aifed sHe B fthee? HIAT
X 4. 99 (sender) & AR SHA Bl Plipd BT
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0.75 Ifg fedt 3uATHEdl 7 feft o= &1 3197 sfd ddie A T &1 A fordr & 3R e off
UHUY 93 A< DY Seld ad-t & & § RAfgd &3 38T &, d 39ATHdl B -1 HI1 91fgu?

Ans x 1.'Add to Reservoir' Jaide B3
x 2.'Add to Book' Helde B3
« 3.'Add to Dictionary' Iciac &
x 4.'Add to Repository' Hald B

Q.76 UHUH TRl 2010 H, SITgHC Bl Ad B3 & felv 3gANT1 f6AT i1 drell Bisel TaI

Q.77 A4 WR URL (I RAA cllbeRr) &1 UrAfiie 389 1 82
Ans .33 IR ) Fareq &1 udr fAfE &

x 2. JIHTSC &b YPHIR Pl Ugdl- Bl
x 3. R BT GISHILr BT gl 1T
x 4. 99 ¢ Pl UHE BT

0.78 I YBR & AIAAT I g1 | uichnifbe araya & wefie fafdre fadvar & &2
Ans x 1. I8 S8 3e¢Thc & SINT Saadr g
x 2. I8 d9 A% fASHT 5T & 519 P o5 I AT o T 7 & S0

v 3. I8 W IR 3791 9fapfa sra ma fafid S5 (keys) & A1 397 P UfpE BT 2|

X 4. g I USRI BIgall bl Shac Bl gl

0.79 fafafEd & d o-3, vaew-93 # 951 7ifsf (page margins) & falv f3hice #1Y 313
&7
Ans 1.5d
x 2.4Uige
x 3. iR
x 4. fAciideR
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0.80 fHY UBR FT $0d NAPid, JoR Pl Ad IR A 391 S0 YF UId B34 I Jfaem &ar &2
Ans x 1. 35d UIei®id (EmailProtocol)

¢ 2. IMAP (8e37¢ BT U TicTapic)
x 3. STP (AT & dididpian)
x 4. FTP (PI8d SIgHR Meibid)

Section : Quantitative Aptitude

0.81 4 fgu v S3® B Id HIfSv]

2 2

ey @ )

Ans 1. E
80

x 2. 26

82

s325

81

x 4. 24

84

Q.82 9H 24 WIdd J@ Al &1 3RId fHa-r gon?
Ans »1.12.5

x2.13
x3.12

x 4.13.5

0.83 o faenef @1 3<iof @17 & ferv quife & 33% 3i yred 31 8311 3 92 37 Ui gy,
ofép 98 40 il A 3ol &1 s/ guife sird Hifsel

Ans x1.500
% 2.600
& 3.400

x4.300
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Ans

Q.85

Ans

Q.86

Ans

0.87

Ans

0.84 f&U IV A3d Bl el HIfFUI

247

075 x = + L f{l+3i}
' 3 7 4% 5
x1.0

x 2.1.35

x 3.0.49

w43

U IATd § 10% HAGIATHT 4 391 I 81 STl 39 g-1d § bdd g 3ufigar & 3R g1d
e Jeoft die de A1 fastdr 3 sra 10 il # F 60% dIC UId B AU Ufdgdl B 108 didl
q &A1 faSidT &1 91 $el dici 1 dAn fea- ofi?

x 1.554
v2.324
x 3.432
x 4.234

U Afth & I 3R d9d BT IFUId 7 : 3 &1 & 319 F 25% ) IfG il & 3R a9 7
8% $I dfg Al 8, dl 39S JF ¥ fPaa faad (1 GUHd U1 d& Yuiifed) B gfg ard

?

x 1.351%

x2.332%

v 3.323%

x 4.31.5%
B9 3 W qF 1 30y B ofi7 31 @1 AR o 91, T g W g3 A 3y H @S A
smesfi| & fpat af &1 § 3R A qF 6 31y fpa-h &2
x 1.40 @9 3R 10 g9

x 2.50 g9 3R 20 a§

x 3. 4599 3R 15 g9

v 4.36T4 3R 12 a9
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Q.88 U® UchIC Bl U gil dacl dd B3 3R ATsfedl F ar9y L&A 1 R 313 7 8 62 30
e &1 Y9 o1l g1 ATE QT d¥% (ST1-3111) I GGl 9ol § 3d 9 §¢ 45 e &1
U IdT &, di 1Al d3% (SATA1-311) ATsfbd Iard § 394 fod=1 gudg b ?

Ans x1.7H¢ 50 e
@ 2.7 89215 e
x 3.7 8¢ 30 fie
x 4.7 g 45 e

0.89 US Iy fbdt S &l gy ursy &1 qar-1 & i A1 dsft F wR APar &1 Afg QT 9rgy
d®: ¢ Bl 24 e T R APd &, d i UIsy gRT 31Pa ¢ &l R4 ¥ fodr 9
Pm?

Ans x 145 f87C
v 2.06 A
x 3. 12% fAe
x 4. 13% e
0.90 HIgHE A TP gl I 1,135 ¥ 51 fFard @A 3R U g1 A 7910 F 49 fFard
Gl gfer fedid 3P gRT PIar & 18 3iRId H1ad (X 7) fea- 82
Ans x1.20.25
X 2.20.65
X 3.20.95

v 4.20.45

Q.91 U a3 &I 3ifhd Yed 3P I oI A 175% AP 81 $8 g a1 & 915 oft gHIqR Bl
32% BT 9 9T gidl &1 gPI1aR g1 &1 18 §e &1 ufdead sird Hifae|

Ans x1.55%
x 2.54%
x 3.49%

v 4.52%

Q.92 30 x 8 x 765 ~ V2025 — y + 540 Pl UGE B AT y PI W1 F1d $Ife]

Ans ., 1.3540
x 2.3541
% 3.3531
x 4.3530
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0.93 U AT9Y QT axqU X 3R Y YA &l 3500 § @Al g1 98 3780 d AP R I I
3ifpd BT &1 98 TG X DI 25% 3R 24% $1 3 B B SHT d9dl & 30 B3 ot 7438
&1 o1 3f3fd B3dr 81 3G 98 avq) Y BT 43% 6 Ubel §e UR 99dT &, dl Y W o1y gfderd
GIGEIIS Y

Ans  x 1. ggeq
X 2. 86.6%
v 3. 87.6%
x4 87%
0.94 Tl 93q &I T19 § 991 UR U ATIRT Bl 10% BT o9 &dl 1 3A aq BT fabd I (T
o, GANId & QI AT dP YUITfed) fHda-1 dgr-r ATfee, drfe 38 30% ST ol al Adb?
Ans x1.545
v 2.3.45
x 3.4.45
x 4.6.45
Q.95 The cost of the watch is increased by 20% on the first day and decreased by 10%
on the second day. What is the percentage increase/decrease?
Ans »1.8% increase
X 2. 8% decrease
% 3.10% increase
X 4.10% decrease
0.96 U YaRI facbdrl 180 H U SclagifIe a3 Wlqdl &1 3UUR 3UNRAY 320 8198 39
gaacife avg @I T360 T 99d1 & 3R x% a1 3Afsfd HIdr1 81 x &1 A1 S1d HIfSv|
Ans »1.80
x 2.100
x3.70

x 4.60
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0.97 ®IS A1d f@R 37l & 16 km/hr &I AT A Il bl g1 &RT HY Il 4 km/hr g1 19 Bl
eRT Y & # 8 km 61 N a7 H7 3R 3T ATT W A19Y @i S 304 F fpd-n1 I9g

(Fret /) edbm?
Ans x1.72
x 2.60
& 3. 64

x 4.68

0.98 d[$d, HIgde 3R I U fATAd &1 &I B 16, 36 3R 24 &1  GRT &R Abd &l
di=l 3 v A1y S YE 16AT1 39 A 2 &7 91 o1 B &A1 3R Argdbd 3 o1 @A 83
A I 4 &7 yga o1 B3 &A1 &1 1 &7 7 ol $od &l 61 d=A1 3ird Hifse)

Ans x1.194
x2.1.2
x3.83

v 4.142

0.99 fAgferfad &1 a19 sird HIfare:
1850 - [450 - {210 - (90 - 80 - 9)}]

Ans x1.1539
x 2.1469
x 3.1684

v 4.1609

0.1007 9 9gdl, A, B 31 C $I 309d 31y 28 a«f i1 3§ F 7 a¥f 415, A 3R C & 3i7d 31 18
ad @it 1 319 F 7 a¥f q1g B B A (el A) fBa- avfi?

Ans x1.89
x 2.87
x 3.91

@ 4.90
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